
Overview 
The default EndNote BibTex output does not contain the required reference types for the IEEE 

standard. Furthermore, the format of the output styles does not match the IEEE standard. Provided 

below are the steps to modify both these facets. The purpose of this document is to highlight how 

we achieved the setups of EndNote and LaTeX we found optimal, and why we made the choices that 

we did. 

Reference Types 
As previously mentioned, the EndNote output styles do not match those of the IEEE standard. 

Furthermore, each reference type has a unique set of input fields. The input fields for each of the 

reference types is provided in the ‘Fields-For-Reference-Types.xls’ file. The reference types and their 

input fields can be exported and imported in EndNote. The configuration for the IEEE standard is 

provided in ‘Final IEEE BiBTex Reference Types.xml’. 

To import the new reference types and their respective input fields, follow the steps given below: 

1. From the navigation header click ‘Edit’ and select ‘Preferences’. 

2. A mini window should popup titled ‘EndNote Preferences’. 

3. Select ‘Reference Types’ from the list on the left. You should now see a subsection titled 

‘Reference Type Table’ . 

4. Click ‘import’ and choose the ‘Final IEEE BiBTex Reference Types.xml’ file. 

This should change the list of reference types available to EndNote and their respective input fields. 

Below is a list of current EndNote reference types and the corresponding IEEE reference types they 

are mapped to.  

1. Journal Article 

2. Artwork -> Trade Journal Article 

3. Book 

4. Ancient Text -> Book Chapter 

5. Book Section 

6. Unused-1 -> Company 

7. Conference Proceedings 

8. Statue -> Datasheet 

9. Grants 

10. Music -> Instruction Manual 

11. Newspaper Article 

12. Issues Patent 

13. Bill -> Patent Publication 

14. Classical Work -> Patent Application 

15. Case -> Provisional Patent Application 

16. Hearing -> Record of Invention 

17. Film of Broadcast -> PhD Thesis 

18. Pamphlet -> Preprint Article 

19. Interview -> MS Thesis 

20. Report 

21. Unused-2 -> Roadmap 

22. Unused-3 -> Software 



23. Standard 

24. Web-page article 

 

A complete list of all 25 primary and secondary reference types is given below. 

Table 1 Primary reference types needed in engineering writing. (25 types) 

Book Grant 

Book Chapter Instruction Manual 

Book Section Issued Patent 

Company Journal Article 

Conference Paper MS Thesis 

Dataset Patent Application 

Datasheet Patent Publication 

PhD Thesis Software 

Preprint Article Standard 

Provisional Patent Application Trade Journal Article 

Record of invention Web-page Article 

Report Newspaper Article 

Roadmap  

 

Table 2  Secondary reference Types that are needed in engineering.  This are implemented within the 

Miscellaneous Universal Reference Type (19 types) 

Accepted Paper Personal Communication 

Application Note Podcast 

Associations Poster 

Blog Post Press Release 

Boards Programs 

BS Thesis Seminar 

Computer Program Unpublished Work 

Conference Presentation without proceedings Video 

Legislative Action Webinar 

Manuscript  

 

The secondary reference types listed above are examples of reference material that are needed in 

engineering but are not covered by the primary list in Table 1. However, any other reference material 

the EndNote user believes is not covered by the primary reference types be cited under 

miscellaneous. 

Miscellaneous Universal Reference Type 
The miscellaneous universal reference type allows the user to reference material that is not covered 

by the primary reference types (Refer to Table 1 above). This includes B.S Thesis, Computer Program, 

manuscript, etc… (Refer to Table 2 above) The miscellaneous universal type contains just two field 

entries – The referenced material type, and the citation. The user must enter the complete citation 

for the material in IEEE style into the second field, and EndNote will export the citation as entered.  

 



BibTex-EndNote Reference Type Mapping 
Each EndNote reference type must be exported as an appropriate BibTex reference type with the 

required fields. The following is a table of BibTex reference types, and the EndNote reference types 

they are linked to.  

BibTex Reference Type EndNote Reference Type 

@article Journal Article 
Trade Journal Article 

@book Book 
Edited Book 

@booklet Preprint Article 

@inbook Book Chapter 
Book Section 

@inproceedings Conference Proceedings 

@mastersthesis MS Thesis 

@misc Company 
Dataset 

Datasheet 
Generic 
Grant 

Instruction Manual 
Issued Patent 
Miscellaneous 

Newspaper Article 
Patent Application 
Patent Publication 

Provisional Patent Application 
Record of Invention 

Roadmap 
Software 
Standard 

Web-Page Article 

@phdthesis Ph.D. Thesis 

@techreport Report 

@unpublished Unpublished Work 

 

To view a list of BibTex fields each EndNote type uses, see the appendix. 

Reference Styles 
The format of an exported reference can be changed by modifying the ‘EndNote style file’ for that 

output style. Changing this style file changes how a certain reference type will look when exported 

from EndNote. This style file was modified to better reflect the IEEE standard and is provided as 

‘BibTex Export Copy.ens’. To import this new style, follow the following documentation: 

https://support.clarivate.com/Endnote/s/article/EndNote-Install-Additional-Output-

Styles?language=en_US 

The steps have also been included here: 

Installing the style into EndNote X2 and later: 

https://support.clarivate.com/Endnote/s/article/EndNote-Install-Additional-Output-Styles?language=en_US
https://support.clarivate.com/Endnote/s/article/EndNote-Install-Additional-Output-Styles?language=en_US


1. In Windows, or using your macOS Finder, browse to the location where you downloaded the 
style. Double-click on the style file to open it. It should open in the EndNote program. 

2. In EndNote, go to the "File Menu" and choose "Save as." 
3. Remove the word "copy" from the end of your style's name, and then click the Save button. 
4. Click on the "File Menu" and choose "Close Style." 
5. [Optional]: To update an existing document with this style, see EndNote: Changing Output 

Styles Within a Document. 

Installing the style into EndNote 8, 9, X, or X1: 

1. Using Windows, or using your macOS Finder, browse to the location where you downloaded 
the style. Right-click on the style file and select Copy. 

2. Browse to your EndNote Styles folder. This will typically be in following location: 
Windows: C:\Program Files\EndNote #\Styles (Where # is the version number for EndNote) 
macOS: Applications\EndNote #\Styles (Where # is the version number for EndNote) 
Note: If you modify the EndNote preferences, you can set this to another location. To check 
this setting, go to the "Edit" menu or EndNote menu on the Mac and select "Preferences." 
Click on the Folder Locations option to see the custom Style folder location and modify as 
needed. Keep in mind that the default location for the Styles folder may cause problems 
when trying to save or edit in Windows Vista, 7, 8, and 10 with versions prior to EndNote X2. 
Please see EndNote: Problems saving Styles for more information on this issue. 

3. Right-click in this folder and choose Paste. Your style should now be installed in the EndNote 
program. 

4. [Optional]: To update an existing document with this style, see EndNote: Changing Output 
Styles Within a Document. 

BibTex Library 
For the output of the EndNote BibTex Export to function as intended, the LaTeX file must be 

modified. The ‘cite’ package must be used in conjunction with the ‘ieeetr’ style. To do this, include 

the following in the preamble of your document:  

\usepackage{cite} 

To ensure the ieee style formatting is used, the following must be added wherever the Bibliography is 

printed: 

\bibliographystyle{ieeetr} 

\bibliography{Bibli} % Where “Bibli” is the name of the .bib file with your 

bibliography entries 

 

By default, this creates a right-aligned Bibliography. However, this could lead to odd spacing between 

bibliography entries. To solve this issue, the following is included in the preamble of the document: 

\raggedright 

 

Alternatively, if this affects other parts of your document, you could use the following: 

\begin{flushleft} 

https://support.clarivate.com/Endnote/s/article/EndNote-Changing-Output-Styles-Within-a-Document
https://support.clarivate.com/Endnote/s/article/EndNote-Changing-Output-Styles-Within-a-Document
https://support.clarivate.com/Endnote/s/article/EndNote-Problems-saving-Styles
https://support.clarivate.com/Endnote/s/article/EndNote-Changing-Output-Styles-Within-a-Document
https://support.clarivate.com/Endnote/s/article/EndNote-Changing-Output-Styles-Within-a-Document


\bibliography{Bibli} % Where “Bibli” is the name of the .bib file with your 

bibliography entries 

\end{flushleft} 

 

Author Name Format 
EndNote’s default naming format dictates how an entered name appears in the reference export. 

This format doesn’t export suffixes correctly to BibTex. It recognizes suffices such as Jr. and Sr. as 

surnames, leaving room for error. This issue was addressed by changing the EndNote settings and 

should be reflected when the ‘BibTex Export Copy.ens’ file was imported. 

1. From the navigation header, select ‘Tools’. 

2. Click ‘Output Styles’ and select “Edit BibTex Export Copy”. 

3. A new window should have opened titled ‘BibTex Export Copy’. 

4. From the navbar on the left select ‘Author Name’ under ‘Bibliography’. 

5. Set the ‘First Author’ field to “Smith, Jane”. 

6. Next, set the ‘Other Authors’ field to “Doe, John”. 

7. Set ‘Capitalization’ to “As Is”. 

8. Ensure the “Capitalize only the author’s last name” checkbox is unselected. 

9. Set ‘Initials’ to “Full Name”. 

This format was chosen as it allows for appropriate exporting for both the default “IEEE” style and 

the created BibTex export. This allows for correct formatting for both LaTeX and Cite While You Write 

(CWYW) users. 

To ensure that any authors with suffixes are appropriately formatted, the following must be done: 

1. Find any authors with suffixes. 

2. Cut the surname and suffix and paste them in front of the maiden name. 

3. Add a comma after the suffix. 

An example is provided below: 

John Doe Jr. -> Doe Jr., John 

Inserting Special Characters  
EndNote’s character set is limited, and hence does not allow certain special characters. This includes 

Greek and Latin characters sometimes found in research papers. The same issue arises in Overleaf 

and other LaTeX compilers. To bypass this issue, search for the appropriate symbol in the ‘LaTex math 

symbols’ list found here: https://oeis.org/wiki/List_of_LaTeX_mathematical_symbols. Type the 

corresponding LaTeX macro into the appropriate section of EndNote to ensure the symbol is correctly 

displayed in LaTeX.  

Alternatively, if you would like to keep your EndNote library compatible with both LaTeX and Cite 

While You Write (CWYW), add the following to the preamble of your LaTeX document: 

\usepackage[mathletters]{ucs} 

\usepackage[utf8x]{inputenc} 

https://oeis.org/wiki/List_of_LaTeX_mathematical_symbols


Make sure you are using Tex Live version 2023. On Overleaf, click the ‘Menu’ button on the top-left 

corner of the page. Then select ‘2023’ from the dropdown for ‘Text Live version’.  

Then, ensure you are using the ASCII version of the character you wish to insert. The appropriate 

symbol can be searched for on this website: https://www.ascii-code.com/characters. This ensures 

compatibility with both LaTeX and CWYW. Note that this method only works for characters that do 

not have any accents. For instance, ‘Greek small letter alpha’ will work, but ‘Greek small letter alpha 

with tonos’ will not display correctly on LaTeX. For these more complex characters, use the 

appropriate LateX macro as mentioned above. It’s also important to note that the Var-theta symbol is 

not currently supported as of the writing of this document. 

Not all LaTeX IDEs can understand the required Greek symbols. Provided below is a list of known 

LaTeX IDEs that accept the required Greek symbols: 

1. Overleaf 

2. TexStudio 

3. TexMaker 

Provided below is a list of LaTeX IDEs that do not understand the required Greek symbols: 

1. Texworks Editor 

2. PcTex 

Changing Reference Type Templates 
This section highlights the process of changing the output template for a particular reference type. 

Here are the steps to undertake the same: 

1. From the navigation header, select ‘Tools’. 

2. Click ‘Output Styles’ and select “Edit BibTex Export Copy”. 

3. A new window should have opened titled ‘BibTex Export Copy’. 

4. From the navbar on the left select ‘Templates’ under ‘Bibliography’. 

5. Click the ‘Reference Types’ button on the top-left of the editing window and select the 

reference type whose reference you wish to change. 

6. Choose an appropriate BibTex base for this template and type all the required LaTeX input 

fields to the left of the ‘=’ sign. 

7. Place your cursor between the curly braces of any input field. 

8. Click the ‘Insert Field’ button on the top-right of the editing window.  

9. Select the EndNote field that corresponds to that LaTeX input field (Or manually type the 

field name).  

10. Repeat this for all LaTeX input fields in the template. 

BibTex Reference Fields 
Each BibTex reference type has a set of reference fields from which it obtains its information. A list of 

reference fields can be found in the ‘bibentries.pdf’ file. The file also contains a list of mandatory and 

optional reference fields for each reference type. When modifying the EndNote reference type 

templates, it is important to choose the appropriate reference type to match the EndNote type. 

Furthermore, once the BibTex reference type is chosen, it is important to ensure that the correct 

reference fields are being filled with the appropriate information. In order of these reference fields 

when compiled by LaTeX may not match the order in which they are exported by EndNote. For 

example, if ‘Title is the first field that is populated by EndNote in its ‘article’ reference template, that 

https://www.ascii-code.com/characters


does not guarantee that the Title will appear first in the reference for articles in the BibTex 

bibliography. The order in the bibliography is decided by the LaTeX package and style you choose. In 

this project, as mentioned in the BibTex Library section, the ‘cite’ package and the ‘ieeetr’ style are 

chosen. 

Conditional Text 
In certain occasions, you may want to include hardcoded text for a field. For example, you may want 

to include the text ‘doi: ’ before the doi of a paper. However, this text must only be displayed if a doi 

exists for that paper. To do this, the hardcoded text can be enclosed in back-ticks (`) and the 

conditional field can be linked with a link character (A degree symbol).  

To do this: 

1. Place your cursor between the curly braces for the appropriate field.  

2. Type the required text between two backticks.  

3. Click the ‘Insert Field’ button on the top-right of the editing window and select the ‘Link 

Adjacent Text’ option. 

4. Then, Click the ‘Insert Field’ button on the top-right of the editing window and choose the 

appropriate EndNote field (Or manually type the field name). 

Multiple EndNote Fields per Input Field 
On certain occasions, you might want to include several EndNote fields in a single BibTex input field. 

For instance, you may want the ‘month’ and ‘year’ fields included under one BibTex ‘date’ field. To do 

this, you can simply include multiple EndNote fields under a single input field. However, if a single 

input field is missing at the start of middle of the list of fields, the subsequent fields will not be filled. 

Furthermore, the closing curly brace will not be included. To bypass the issue, do the following: 

Include a ‘space character’ as the first and last characters within the curly braces. This can be 

inserted by hitting the ‘space bar’ key on your keyboard. This character is represented on EndNote by 

a dot. Adding the prefix and suffix spaces ensures that the curly brace is included in exporting and 

that any missing fields do not prevent the exporting of other fields. 

Here is an example: 

|   `Date = `{ month, year }, 

Quotations 
Often, the ‘Title’ field must be enclosed in quotation marks. BibTex automatically inserts the 

quotation marks for the ‘Title’ field of several Reference Types including Book, Book Chapter, Book 

Section etc... However, in other Reference Types, this quotation mark is not automatically included, 

including Grant, Issued Patent, Instruction Manual etc… This issue often occurs with the ‘@misc’ 

reference type. In these cases, the quotations can be manually inserted in the template. However, 

the regular quotation marks, called straight quotes, shown here: "", differ from the ones 

automatically inserted by some BibTex styles. As a result, a discrepancy can sometimes arise that 

creates a non-uniform appearance. To change this, we can, if appropriate, insert a modified 

quotation mark character, called curly quotes, shown here: “”. Matching the quotation characters 

automatically inserted by BibTex provides a more uniform Bibliography export. 

The following is a list of BibTex reference types which do not automatically include quotations: 

1. @inbook – Chapter field 

2. @misc 



3. @phdthesis 

Plain Tex 
If you wish to write plain Tex rather than LaTeX, popular Integrated Development Environments 

(IDEs) such as Overleaf and TexStudio will not work. Provided below is a list of IDEs that are 

recommended for plain Tex: 

1. Texworks Editor 

2. PcTex 

 

Appendix 
 

Table-1: Map of EndNote Reference Style and BibTex Fields. 

EndNote Reference Type Corresponding BibTex Fields 

Book BibTex Reference Type: @book 
1. Author 
2. Title 
3. Publisher 
4. Address 
5. Year 
6. Type 

Book Chapter BibTex Reference Type: @inbook 
1. Author 
2. Title 
3. Booktitle 
4. Editor 
5. Series 
6. Publisher 
7. Address 
8. Volume 
9. Chapter 
10. Note 
11. Abstract 
12. Keywords 
13. ISBN 
14. DOI 
15. URL 
16. Year 
17. Type 

Book Section BibTex Reference Type: @inbook 
1. Author 
2. Title 
3. Booktitle 
4. Editor 
5. Series 
6. Publisher 
7. Address 
8. Volume 
9. Chapter 
10. Note 
11. Abstract 
12. Keywords 
13. ISBN 
14. DOI 
15. URL 
16. Year 
17. Type 



Company BibTex Reference Type: @misc 
1. Note 
2. Type 

Conference Proceedings BibTex Reference Type: @inproceedings 
1. Author 
2. Title 
3. Note 
4. Type 

Dataset BibTex Reference Type: @misc 
1. Author 
2. Title 
3. Note 
4. Year 
5. Type 

Datasheet BibTex Reference Type: @misc 
1. Note 
2. Type 

Grant BibTex Reference Type: @misc 
1. Author 
2. Title 
3. Year 
4. Type 

Instruction Manual BibTex Reference Type: @misc 
1. Note 
2. Type 

Issued Patent BibTex Reference Type: @misc 
1. Note 
2. Type 

Journal Article BibTex Reference Type: @article 
1. Author 
2. Title 
3. Journal 
4. Volume 
5. Pages 
6. Note 
7. Year 
8. Month 
9. Type 

MS Thesis BibTex Reference Type: @mastersthesis 
1. Author 
2. Title 
3. Note 
4. Type 

Newspaper Article BibTex Reference Type: @misc 
1. Author 
2. Year 
3. Type 

Patent Application BibTex Reference Type: @misc 
1. Note 
2. Type 

Patent Publication BibTex Reference Type: @misc 
1. Note 
2. Type 

PhD Thesis BibTex Reference Type: @phdthesis 
1. Author 
2. Title 
3. Type 
4. School 

Preprint Article BibTex Reference Type: @booklet 
1. Author 
2. Title 
3. Publisher 
4. Address 
5. Pages 
6. ISBN 
7. DOI 



8. Note 
9. Year 
10. Type 

Provisional Patent Application BibTex Reference Type: @misc 
1. Note 
2. Type 

Record of Invention BibTex Reference Type: @misc 
1. Year 
2. Author 
3. Type 

Report BibTex Reference Type: @techreport 
1. Author 
2. Title 
3. Institution 
4. Month 
5. Year 
6. Type 

Roadmap BibTex Reference Type: @misc 
1. Note 

Software BibTex Reference Type: @misc 
1. Note 
2. Type 

Standard BibTex Reference Type: @misc 
1. Author 
2. Title 
3. Month 
4. Year 
5. Type 

Trade Journal Article BibTex Reference Type: @article 
1. Author 
2. Title 
3. Journal 
4. Volume 
5. Pages 
6. Note 
7. Year 
8. Month 
9. Type 

Web-page article BibTex Reference Type: @misc 
1. Note 
2. Type 

 


